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1 HP DeskJet GT 5810 series Help

Learn how to use your HP DeskJet GT 5810 series .

● Get started on page 2

● Print on page 24

● Copy and scan on page 33

● Manage ink and printhead on page 39

● Connect your printer on page 48

● Solve a problem on page 50

● Technical information on page 80
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2 Get started

● Printer parts

● Get to know the ink tank system

● Control panel features

● Control panel lights and display icons status

● Load media

● Load an original on the scanner glass

● Paper basics

● Open the HP printer software (Windows)

● Sleep mode

● Quiet Mode

● Auto-Off 

2 Chapter 2   Get started ENWW



Printer parts

1 Paper-width guide

2 Input tray

3 Input tray shield

4 Scanner lid

5 Scanner glass

6 Output tray extender (also referred to as the tray extender)

7 Output tray

8 Front door

9 Ink valve

10 Ink tank

11 Ink tank caps

12 Ink tank lid

13 Control panel

14 Printhead access door
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15 Printheads

16 Printhead latch

17 Power connection

18 USB port
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Get to know the ink tank system
Get to know the HP DeskJet GT 5810 series ink tank system.

Term Definition

Printheads The printheads are the components in the print mechanism that apply ink to the paper. There are two 
printheads: a black ink printhead and a tri-color ink printhead. Once the printheads are installed, they 
should not be removed from the print carriage.

Printhead latch The printhead latch on the carriage secures the printheads in the carriage. The printhead latch should not 
be opened after the printheads are installed and the ink system has primed.

Ink tanks Ink tanks are external ink reservoirs located at the right side of the printer. There are four ink tanks. Each 
ink tank corresponds to an individual color: black, cyan, magenta, and yellow.

Ink tank caps Ink tank caps are rubber plugs that seal each ink tank.

Ink valve The ink valve switch on the side of the ink tank controls the flow of ink between the tanks and the 
printheads. For more information, see Ink valve on page 40

Priming Priming is the process of filling the ink supply tubes that run between the ink tanks and the printheads. 
This process occurs when you install new printheads and start the priming process from the control panel. 
For more information about priming, see Printhead priming and alignment icons on page 9.

Alignment Alignment is a process of aligning the printheads to improve print quality. For more information about 
alignment, see Printhead priming and alignment icons on page 9.
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Control panel features
Overview of buttons and lights

Feature Description

1 Control Panel Display : Indicates number of copies, printhead priming status, media errors, and printhead 
problems.

2 Cancel button: Stops the current operation.

3 Resume button: Resumes a job after a disruption (for example, after loading paper or clearing a paper jam).

Resume light: Indicates the printer is in a warning or error state.

4 Start Copy Color button: Starts a color copy job. To increase the number of color copies, press the button 
multiple times. Copying will start two seconds after the last button press.

NOTE: You can generate a print quality diagnostics report by pressing and holding the Start Copy Color 
button for 3 seconds.

5 Start Copy Black button: Starts a black-and-white copy job. To increase the number of black-and-white 
copies, press the button multiple times. Copying will start two seconds after the last button press.

6 Power button: Turns the printer on or off.

7 Printhead Alert light: Indicates printhead problems.
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Control panel display icons

Icon Description

Number of copies icon: Shows the number of copies when you are copying documents, changes to the 
letter P when the printer needs priming, and alternates between the letter E and a number when the 
printer is in an error state.

Error icon: Indicates an error.

Paper Error icon: Indicates a paper-related error.

Printhead icons: The left printhead icon flashing shows an error related to the tri-color printhead, and 
the right icon flashing shows an error related to the black printhead
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Control panel lights and display icons status
● Power button light

● Printhead icons and Printhead Alert light

● Printhead priming and alignment icons

● Error icon, Paper Error icon, and Resume light

● Number of copies icon

● Ink system maintenance icon

Power button light

Status Description

On The printer is on.

Off The printer is powered off.

Dimmed Indicates the printer is in Sleep mode. The printer automatically enters Sleep mode after 5 minutes 
of inactivity. After 2 hours of Sleep mode, the printer automatically turns off if not connected to a 
wireless network.

Blinking The printer is processing a job. To cancel the job, press the Cancel button ( ).

Fast blinking If the printhead access door is open, close it. If the printhead access door is closed and the light is 
fast blinking, the printer is in an error state that you can resolve by following the on-screen 
messages from the computer. If you do not see any on-screen messages, try printing a document to 
generate an on-screen message.

Printhead icons and Printhead Alert light
● The Error icon, one of the Printhead icons, and the Printhead Alert light are blinking.
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Cause Solution

One of the following might have occurred.

— The corresponding printhead is missing.

— The corresponding printhead is installed incorrectly.

— The corresponding printhead still has orange plastic tape 
or the plug on it.

— If one of the printheads is missing, insert the 
corresponding printhead.

— If both printheads are installed in the printer, remove the 
corresponding printhead, make sure there is no plug or 
plastic tape on it, and then reinsert the printhead 
securely.

CAUTION: These instructions only apply when you 
install pritheads during initial printer setup. If the 
printheads have been primed with ink, you must not 
open the printhead latch. Opening the latch can cause 
permanent damage to the printheads.

For more information, see Fix printhead problems 
on page 59.

● The Error icon, both Printhead icons, and the Printhead Alert light are blinking.

Cause Solution

One of the following might have occurred.

— Both printheads are missing.

— Both printheads are installed incorrectly.

— Both printheads still have orange plastic tapes or plugs 
on them.

— Both printheads are incompatible or damaged.

— If there are no printheads installed in the printer, install 
the printheads.

— If both printheads are installed in the printer, remove the 
printheads, make sure there is no plug or plastic tape on 
them, and then reinsert the printheads securely.

CAUTION: These instructions only apply when you 
install pritheads during initial printer setup. If the 
printheads have been primed with ink, you must not 
open the printhead latch. Opening the latch can cause 
permanent damage to the printheads.

— Make sure that you are using the correct HP printheads 
for your printer.

— If the error persists, contact HP Support for help.

Printhead priming and alignment icons

Printheads ready for priming

● The Number of copies icon changes to a blinking P during initial printer setup. At the same time all other 
icons on the control panel display are turned off.
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Cause Solution

During initial setup, the printer detects that the new 
printheads are installed and the ink system is ready for 
priming.

Make sure all ink tanks are filled above the minimum line, and 
the blue printhead latch is closed firmly. Press and hold the 

Resume button ( ) for 3 seconds to start ink priming.

NOTE: Priming will occur in the background and will not 
block printing or copying.

Alignment status icon

● The Number of copies icon becomes a blinking A.

Cause Solution

The alignment page is printing and waiting to scan. Place the alignment page print side down on the scanner 

glass, and then press the Start Copy Color button ( ) on 

the control panel to align.

NOTE: When scan starts, blinking "A" changes to solid "A". 
Alignment is complete after the scan. 

— If alignment event occurs as part of the priming process 
during initial printer setup, the solid "A" changes to 
rotating lines once alignment is complete.

— If alignment event occurs after initial printer setup, the 
control panel display returns to normal state once 
alignment is complete.

Error icon, Paper Error icon, and Resume light
The Error icon, the Paper Error icon, and the Resume light are blinking.

Cause Solution

The printer receives a printing job, and detects that there is no 
paper in the input tray.

Load paper, and then press the Resume button ( ) to continue 

printing.

For information about how to load paper, see Load media 
on page 13.

Number of copies icon
● The Number of copies icon is alternating between the letter E and the number 3. At the same time, the 

Resume light is blinking, and the Power button light is on.

10 Chapter 2   Get started ENWW



Cause Solution

The carriage inside the printer has stalled. Open the printhead access door and make sure the carriage is 
not obstructed. Move the carriage to the right, close the 
printhead access door, and then press the Resume button 

( ) to continue printing. See Jams and paper-feed issues 

on page 51 for more information.

CAUTION: You must not open the printhead latch during this 
process if printheads have been primed with ink. Opening the 
latch can cause permanent damage to the printheads.

● The Number of copies icon is alternating between the letter E and the number 4. At the same time, the 
Error icon, the Paper Error icon, and the Resume light are blinking.

Cause Solution

There is a paper jam. Clear the jam, and then press the Resume button ( ) to 

continue printing.

For more information, see Jams and paper-feed issues 
on page 51.

● The Number of copies icon is alternating between the letter E and the number 5. At the same time, all 
lights on the control panel are blinking.

Cause Solution

The scanner is not working. Turn off and turn on the printer.

If the problem persists, contact HP. The printer still prints even 
if the scanner is not working.

● The Number of copies icon is alternating between the letter E and the number 6.
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Cause Solution

The printer is in an error state. Reset the printer.

1. Turn off the printer.

2. Unplug the power cord.

3. Wait a minute, and then plug the power cord back in.

4. Turn on the printer.

If the problem persists, contact HP.

Ink system maintenance icon
The Number of copies icon is alternating between the letter E and the number 9.

Cause Solution

The printer detects that ink system maintenance is required. Open the printhead access door completely, and then close it 
immediately. This process helps remove ink buildup and 
maintains the best print quality throughout the life of the printer.

CAUTION: Do not open the blue printhead latch during this 
process; otherwise, the printer may require new printheads to 
function.
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Load media
Select a paper size to continue.

To load full-size paper

1. Raise the input tray.

2. Slide the paper-width guide to the left.

3. Insert a stack of paper into the input tray with the short edge down and the print side up, and slide the 
stack of paper down until it stops.
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4. Slide the paper-width guide to the right until it stops at the edge of the paper.

5. Pull out the output tray and the tray extender.

To load small-size paper

1. Raise the input tray.

2. Slide the paper-width guide to the left.
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3. Insert a stack of small-size paper (like photo paper) into the far-right side of the input tray with the 
short edge down and the print side up, and slide the stack of paper down until it stops.

4. Slide the paper-width guide to the right until it stops at the edge of the paper.

5. Pull out the output tray and the tray extender.

To load envelopes

1. Raise the input tray.
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2. Slide the paper-width guide to the left.

3. Insert one or more envelopes into the far-right side of the input tray and slide the stack of envelopes 
down until it stops.

The side to be printed on should face up. For envelope with flap on the long edge, insert the envelope 
vertically with the flap on the left side and facing down. For envelope with the flap on the short edge, 
insert the envelope vertically with the flap on the top and facing down.

4. Slide the paper-width guide to the right against the stack of envelopes until it stops.

5. Pull out the output tray and the tray extender.
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Load an original on the scanner glass
To load an original on the scanner glass

1. Lift the scanner lid.

2. Load the original print-side down on the right corner of the scanner glass.

3. Close the scanner lid.
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Paper basics
The printer is designed to work well with most types of office paper. It is best to test a variety of print paper 
types before buying large quantities. Use HP paper for optimum print quality. Visit the HP website at 
www.hp.com for more information about HP paper.

HP recommends plain papers with the ColorLok logo for printing everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of 
reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, 
and that dry faster than ordinary plain papers. Look for papers with the ColorLok logo in 
a variety of weights and sizes from major paper manufacturers.

This section contains the following topics:

● Recommended papers for printing

● Order HP paper supplies

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically designed for the type 
of project you are printing.

Depending on your country/region, some of these papers might not be available.

Photo printing

● HP Premium Plus Photo Paper

HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With HP 
Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can share them 
right off the printer. It is available in several sizes, including A4, 8.5 x 11 inches, 4 x 6 inches (10 x 15 
cm), 5 x 7 inches (13 x 18 cm), and in two finishes - glossy or soft gloss (semi-gloss). Ideal for framing, 
displaying, or gifting your best photos and special photo projects. HP Premium Plus Photo Paper delivers 
exceptional results with professional quality and durability.

● HP Advanced Photo Paper

This glossy photo paper features an instant-dry finish for easy handling without smudging. It resists 
water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inches, 10 x 15 cm (4 x 6 inches), 
13 x 18 cm (5 x 7 inches). It is acid-free for longer lasting documents.

● HP Everyday Photo Paper

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This 
affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper 
with any inkjet printer. It is available in glossy finish in several sizes, including A4, 8.5 x 11 inches, 5 x 7 
inches, and 4 x 6 inches (10 x 15 cm). It is acid-free for longer lasting documents.

● HP Photo Value Packs

HP Photo Value Packs conveniently package original HP ink cartridges and HP Advanced Photo Paper to 
save you time and take the guesswork out of printing affordable, lab-quality photos with your HP 
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printer. Original HP inks and HP Advanced Photo Paper have been designed to work together so your 
photos are long lasting and vivid, print after print. Great for printing out an entire vacation's worth of 
photos or multiple prints to share.

Business documents

● HP Premium Presentation Paper 120g Matte or HP Professional Paper 120 Matt

This paper is a heavy two-sided matte paper perfect for presentation, proposals, reports, and 
newsletters. It is heavyweight for an impressive look and feel.

● HP Brochure Paper 180g Glossy or HP Professional Paper 180 Glossy

These papers are glossy-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.

● HP Brochure Paper 180g Matte or HP Professional Paper 180 Matte

These papers are matte-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.

Everyday printing

All the papers listed for everyday printing feature ColorLok Technology for less smearing, bolder blacks, and 
vivid colors.

● HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-
sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers.

● HP Printing Paper

HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more 
substantial than documents printed on standard multipurpose or copy paper. It is acid-free for longer 
lasting documents.

● HP Office Paper

HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other 
everyday documents. It is acid-free for longer lasting documents.

● HP Office Recycled Paper

HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled fiber.

Order HP paper supplies
The printer is designed to work well with most types of office paper. Use HP paper for optimum print quality.

To order HP papers and other supplies, go to www.hp.com . At this time, some portions of the HP website are 
available in English only.

HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, 
and produce documents with crisp, vivid color, bolder blacks and shorter dry-time than ordinary plain papers. 
Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.
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Open the HP printer software (Windows)
After installing the HP printer software, double-click the printer icon on the desktop or do one of the following 
to open the printer software:

● Windows 10: From the computer desktop, click Start, select All apps, click HP, click the folder for the 
printer, and then select the icon with the printer's name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the printer 
name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then select 
the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.
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Sleep mode
● Power usage is reduced while in Sleep mode.

● After initial setup of printer, the printer will enter Sleep mode after 5 minutes of inactivity.

● The Power button light is dimmed and the printer control panel display is off in Sleep mode.

● Pressing any button on the control panel, or sending a print or scan job can wake up the printer from 
sleep mode.
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Quiet Mode
Quiet Mode slows down printing to reduce overall noise without affecting print quality. Quiet Mode only works 
for printing with Normal print quality on plain paper. To reduce printing noise, turn on Quiet Mode. To print at 
normal speed, turn Quiet Mode off. Quiet Mode is off by default.

NOTE: In Quiet Mode, if you print on plain paper with the Draft or Best print quality, or if you print photos or 
envelopes, the printer works in the same way as when Quiet Mode is off.

To turn Quiet Mode on or off from the printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows) 
on page 20.

2. Click the Quiet Mode tab.

3. Click On or Off.

4. Click Save Settings.
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Auto-Off
This feature turns the printer off after 2 hours of inactivity to help reduce energy use. Auto-Off turns the 
printer off completely, so you must use the Power button to turn the printer back on. If your printer 
supports this energy saving feature, Auto-Off is automatically enabled or disabled depending on printer 
capabilities and connection options. Even when Auto-Off is disabled, the printer enters Sleep mode after 5 
minutes of inactivity to help reduce energy use.

● Auto-Off is enabled when the printer is turned on, if the printer does not have network or fax capability, 
or is not using these capabilities.

● Auto-Off is disabled when a printer’s wireless or Wi-Fi Direct capability is turned on or when a printer 
with fax, USB, or Ethernet network capability establishes a fax, USB, or Ethernet network connection.
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3 Print

● Print from your computer

● Tips for print success
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Print from your computer
● Print documents

● Print photos

● Print envelopes

● Print using the maximum dpi

Print documents
Before printing documents, make sure you have paper loaded in the input tray and the output tray is open. 
For more information about loading paper, see Load media on page 13.

To print a document (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then 
select the appropriate color in the Color area.

● Click Advanced to select the appropriate paper size from the Paper Size drop-down list.

5. Click OK to close the Properties dialog box.

6. Click Print or OK to begin printing.

To print documents (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

● Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size, ensure that you have loaded the correct paper.

● Select the orientation.

● Enter the scaling percentage.

4. Click Print.
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To print on both sides of the page (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then 
select the appropriate color in the Color area.

● Click Advanced to select the appropriate paper size from the Paper Size drop-down list.

5. On the Layout tab, select an appropriate option from the Print on Both Sides Manually drop-down list.

6. After you print the first side, follow the on-screen instructions to reload the paper with the blank side up 
and top of the page down, and then click Continue.

7. Click OK to print.

To print on both sides of the page (OS X)

1. From the File menu in your software, choose Print.

2. In the Print dialog, choose Paper Handling from the pop-up menu and set Page Order to Normal.

3. Set Pages to Print to Odd only.

4. Click Print.

5. After all of the odd numbered pages have printed, remove the document from the output tray.

6. Reload the document so that the end that came out of the printer is now going into the printer and the 
blank side of the document is facing toward the front of the printer.

7. In the Print dialog, return to the Paper Handling pop-up menu and set the page order to Normal and the 
pages to print to Even Only.

8. Click Print.

Print photos
Before printing photos, make sure you have photo paper loaded in the input tray and the output tray is open. 
For more information about loading paper, see Load media on page 13.

To print a photo on photo paper (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.
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3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then 
select the appropriate color in the Color area.

● Click Advanced to select the appropriate photo size from the Paper Size drop-down list.

5. Click OK to return to the Properties dialog box.

6. Click OK, and then click Print or OK in the Print dialog box.

NOTE:  After the printing is finished, remove unused photo paper from the input tray. Store the photo paper 
so it does not start to curl, which could reduce the quality of your printout. 

To print a photo from the computer (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

● Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size ensure that you have loaded the correct paper.

● Select the orientation.

4. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:

● Paper Type: The appropriate photo paper type

● Quality: Select the option that provides the best quality or maximum dpi.

● Click the Color Options disclosure triangle, and then choose the appropriate Photo Fix option.

— Off: applies no changes to the image.

— On: automatically focuses the image; moderately adjusts image sharpness.

5. Select any other print settings you want, and then click Print.

Print envelopes
Before printing envelopes, make sure you have envelopes loaded in the input tray and the output tray is open. 
You can load one or more envelopes into the input tray. Do not use shiny or embossed envelopes or envelopes 
that have clasps or windows. For more information about loading envelopes, see Load media on page 13.
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NOTE: For specific details on how to format text for printing on envelopes, consult the help files in your 
word application.

To print an envelope (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then 
select the appropriate color in the Color area.

● Click Advanced to select the appropriate envelope size from the Paper Size drop-down list.

5. Click OK, and then click Print or OK in the Print dialog box.

To print envelopes (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Select the appropriate envelope size from the Paper Size pop-up menu.

If you do not see options on the Print dialog, click Show Details.

NOTE: If you change the paper size, ensure that you have loaded the correct paper.

4. From the pop-up menu, choose Paper Type/Quality, and verify the paper type setting is set to Plain 
Paper.

5. Click Print.

Print using the maximum dpi
Use maximum dots per inch (dpi) to print high-quality, sharp images on photo paper.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk 
space.

For a list of supported print resolutions, visit the HP DeskJet GT 5810 series support website at www.hp.com/
support.

To print in maximum dpi mode (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.
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3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Click the Paper/Quality tab.

5. From the Media drop-down list, select an appropriate paper type.

6. Click the Advanced button.

7. In the Printer Features area, select Yes from the Print in Max DPI drop-down list.

8. Select the appropriate paper size from the Paper Size drop-down list.

9. Click OK to close the advanced options.

10. Confirm Orientation on the Layout tab, and then click OK to print.

To print using maximum dpi (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

● Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size ensure that you have loaded the correct paper.

● Select the orientation.

4. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:

● Paper Type: The appropriate paper type

● Quality: Maximum dpi

5. Select any other print settings that you want, and then click Print.
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Tips for print success
● Printhead and ink tips

● Paper loading tips

● Printer settings tips 

● Notes

To print successfully, the HP printheads should be functioning properly, the ink tanks should be filled with 
sufficient ink, the ink valve should be at the unlocked position, the paper should be loaded correctly, and the 
printer should have the appropriate settings.

Print settings do not apply to copying or scanning.

Printhead and ink tips
● Use original HP printheads.

● Install both the black and tri-color printheads correctly.

For more information, see Fix printhead problems on page 59.

● Check the ink levels on the ink tanks to make sure there is sufficient ink.

For more information, see Ink levels on page 41.

● If the print quality is not acceptable, see Printing issues on page 65 for more information.

Paper loading tips
● Load a stack of paper (not just one page). All of the paper in the stack should be in the same size and 

type to avoid a paper jam.

● Load the paper with side to be printed on facing up.

● Ensure that paper loaded in the input tray lays flat, and the edges are not bent or torn.

● Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width 
guide does not bend the paper in the input tray.

For more information, see Load media on page 13.

Printer settings tips

Printer settings tips (Windows)

● To change default print settings, open the HP printer software, click Print & Scan , and then click Set 
Preferences. For information how to open the printer software, see Open the HP printer software 
(Windows) on page 20.

● To select the number of pages to print per sheet, on the Layout tab, select the appropriate option from 
the Pages per Sheet drop-down list.

● To view more printing settings, on the Layout or Paper/Quality tab, click the Advanced button to open 
the Advanced Options dialog box.
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— Print in Grayscale: Allows you to print a black and white document using the black ink only. Select 
Black Ink Only, and then click OK . It also allows you to print a high quality black and white image. 
Select High Quality Grayscale, and then click OK .

— Pages per Sheet Layout: Helps you specify the order of the pages if you print the document with 
more than two pages per sheet.

NOTE: The preview on the Layout tab cannot reflect what you select from the Pages per Sheet 
Layout drop-down list.

— HP Real Life Technologies: This feature smooths and sharpens images and graphics for improved 
print quality.

— Booklet: Allows you to print a multiple-page document as a booklet. It places two pages on each 
side of a sheet that can then be folded into a booklet in half size of the paper. Select a binding 
method from the drop-down list, and then click OK.

○ Booklet-LeftBinding: The binding side after folded into a booklet appears at the left side. 
Select the option if your reading habit is from left to right.

○ Booklet-RightBinding: The binding side after folded into a booklet appears at the right side. 
Select the option if your reading habit is from right to left.

NOTE: The preview on the Layout tab cannot reflect what you select from the Booklet drop-
down list.

— Pages to Print: Allows you to print the odd pages only, print the even pages only, or print all pages.

— Borderless Printing: Select this feature to print photos without border. Not all paper types support 
this feature. You will see an alert icon beside the option if the selected paper type in the Media 
drop-down list does not support it.

— Page Borders: Allows you to add borders to the pages if you print the document with two or more 
pages per sheet.

NOTE: The preview on the Layout tab cannot reflect what you select from the Page Borders 
drop-down list.

● You can use printing shortcut to save time setting printing preferences. A printing shortcut stores the 
setting values that are appropriate for a particular kind of job, so that you can set all the options with a 
single click. To use it, go to the Printing Shortcut tab, select one printing shortcut, and then click OK.

To add a new printing shortcut, after making settings on the Layout or Paper/Quality tab, click the 
Printing Shortcut tab, click Save As and enter a name, and then click OK.

To delete a printing shortcut, select it, and then click Delete.

NOTE: You cannot delete the default printing shortcuts.

Printer settings tips (OS X)

● On the Print dialog, use the Paper Size pop-up menu to select the size of paper loaded in the printer.

● On the Print dialog, choose the Paper Type/Quality pop-up menu and select the appropriate paper type 
and quality.

● To print a black and white document using only black ink, choose the Paper Type/Quality from the pop-
up menu and choose Grayscale from the Color pop-up menu.
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Notes
● Original HP printheads and ink are designed and tested with HP printers and papers to help you easily 

produce great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs 
required as a result of using a non-HP supply will not be covered under warranty.
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4 Copy and scan

● Copy documents

● Scan using the HP printer software

● Tips for copy and scan success
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Copy documents
NOTE: All documents are copied in normal quality print mode. You cannot change the print mode quality 
when copying.

To copy documents

1. Load paper in the input tray.

For information about how to load paper, see Load media on page 13.

2. Load the original print side down on the right front corner of the scanner glass.

For more information, see Load an original on the scanner glass on page 17.

3. Press either the Start Copy Black button ( ) or the Start Copy Color button ( ) to make a copy.

Copying will start two seconds after the last button press.

TIP: You can increase the number of copies by pressing the button multiple times.
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Scan using the HP printer software
● Scan from a computer

● Change scan settings (Windows)

● Create a new scan shortcut (Windows)

Scan from a computer
Before scanning from a computer, make sure you have already installed the HP recommended printer 
software. The printer and computer must be connected and turned on.

To scan a document or photo to a file (Windows)

1. Load the original print side down on the right front corner of the scanner glass.

2. Double-click the printer icon on the desktop or do one of the following to open the printer software:

● Windows 10: From the computer desktop, click Start, select All apps, click HP, click the folder for 
the printer, and then select the icon with the printer's name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

3. In the printer software, click Scan a Document or Photo .

4. Select the type of scan you want and then click Scan .

● Choose Save as PDF to save the document (or photo) as a PDF file.

● Choose Save as JPEG to save the photo (or document) as an image file.

NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for 
any scan.

For more information, see Change scan settings (Windows) on page 36.

If Show Viewer After Scan is selected, you can make adjustments to the scanned image in the preview 
screen.

To scan an original from HP printer software (OS X)

1. Open HP Scan.

HP Scan is located in the Applications/HP folder at the top level of the hard disk.

2. Click Scan .

3. Choose the type of scan profile you want and follow the on-screen instructions.
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Go online to learn more about using the HP Scan software. Learn how to:

● customize scan settings, such as image file type, scan resolution, and contrast levels.

● preview and adjust images before scanning.

Change scan settings (Windows)
You can modify any of the scan settings either for a singular use or save the changes to use permanently. 
These settings include options such as page size and orientation, scan resolution, contrast, and the folder 
location for saved scans.

1. Load the original print side down on the right front corner of the scanner glass.

2. Double-click the printer icon on the desktop or do one of the following to open the printer software:

● Windows 10: From the computer desktop, click Start, select All apps, click HP, click the folder for 
the printer, and then select the icon with the printer's name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

3. In the printer software, click Scan a Document or Photo .

4. Click the More link in the top right corner of the HP Scan dialog.

The detailed settings pane appears on the right. The left column summarizes the current settings for 
each section. The right column allows you to change the settings in the highlighted section.

5. Click each section at the left of the detailed settings pane to review the settings in that section.

You can review and change most settings using drop-down menus.

Some settings allow greater flexibility by displaying a new pane. These are indicated by a + (plus sign) at 
the right of the setting. You must either accept or cancel any changes on this pane to return to the 
detailed settings pane.

6. When you have finished changing settings, do one of the following.

● Click Scan . You are prompted to save or reject the changes to the shortcut after the scan is 
finished.

● Click the save icon to the right of the shortcut, and then click Scan .

Go online to learn more about using the HP Scan software. Learn how to:

● customize scan settings, such as image file type, scan resolution, and contrast levels.

● preview and adjust images before scanning.
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Create a new scan shortcut (Windows)
You can create your own scan shortcut to make scanning easier. For example, you might want to regularly 
scan and save photos in PNG format, rather than JPEG.

1. Load the original print side down on the right front corner of the scanner glass.

2. Double-click the printer icon on the desktop or do one of the following to open the printer software:

● Windows 10: From the computer desktop, click Start, select All apps, click HP, click the folder for 
the printer, and then select the icon with the printer's name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

3. In the printer software, click Scan a Document or Photo .

4. Click Create New Scan Shortcut .

5. Enter a descriptive name, choose an existing shortcut on which to base your new shortcut, and then click 
Create .

For example, if you are creating a new shortcut for photos, choose either Save as JPEG or Email as 
JPEG . This makes available the options for working with graphics when scanning.

6. Change the settings for your new shortcut to meet your needs, and then click the save icon to the right 
of the shortcut.

NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for 
any scan.

For more information, see Change scan settings (Windows) on page 36.
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Tips for copy and scan success
Use the following tips to copy and scan successfully:

● Keep the glass and the back of the lid clean. The scanner interprets anything it detects on the glass as 
part of the image.

● Load your original, print side down, on the right front corner of the glass.

● To make a large copy of a small original, scan the original into the computer, resize the image in the 
scanning software, and then print a copy of the enlarged image.

● To avoid incorrect or missing scanned text, make sure the brightness is set appropriately in the 
software.
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5 Manage ink and printhead

This section contains the following topics:

● Ink valve

● Ink levels

● Refill Ink Tanks

● Order ink supplies

● Print with black ink only

● Tips for working with ink and printhead
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Ink valve
To prevent ink leakage, make sure the ink valve is locked before you attempt to move or tilt the printer. Turn 
the valve completely to the right (horizontal position) to lock.

After moving the product and before you print, make sure the ink valve is unlocked, allowing the printer to 
function properly. Turn the valve completely to the left (vertical position) to unlock.
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Ink levels
Use the ink level lines on the ink tanks to determine when to fill the tanks and how much ink should be added.

1 Maximum line: The actual ink level should not be higher than the maximum line.

2 Minimum line: The actual ink level should not be lower than the minimum line.

Match the color of the ink bottle to the color on the tank when you fill the tanks, and seal the rubber ink tank 
caps properly after that.

The ink level in each tank will be a little bit below the maximum fill line when you first fill the tanks.

If you notice any ink level reaches the minimum line during daily printing, refill that tank with correct ink. 
Printing with ink level below the minimum line may cause damage to your printer.

When you refill the ink tanks, fill the ink to the maximum lines only. Any ink level above the maximum line 
may cause ink leakage.

NOTE: Product service or repairs required as a result of filling the ink tanks improperly and/or using non-HP 
ink will not be covered under warranty.

ENWW Ink levels 41



Refill Ink Tanks
To refill the ink tanks

1. Lift the ink tank lid.

2. Remove the cap of the ink tank you plan to refill.

3. Twist to remove the cap of the ink bottle, remove the seal from the bottle, install the cap back onto the 
bottle, and then pull open the top part of the cap.
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4. Hold the ink bottle on tank nozzle and refill the ink tank to the maximum line only. If ink doesn't drain 
immediately, remove and reinsert bottle on tank.

CAUTION: You should not squeeze the ink bottle during this process.

NOTE: Some ink will remain in the bottle after filling the tank to the maximum level line. Store the 
bottle in an upright position in a cool and dry location.

5. Close the ink tank cap securely.

6. Repeat steps 2 to 5 to refill other ink tanks.

7. Close the ink tank lid.

Precautions for working with ink bottles

Use the following tips to work with ink bottles:

● Keep the ink bottles beyond the reach of children.

● Open the ink bottle only when you plan to fill the ink tanks.
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● Do not tilt, shake, or squeeze the ink bottle when it is open in case ink leaks.

● Store the ink bottles in a cool, dark place.
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Order ink supplies
Before ordering ink bottles, visually check the labels on the ink bottles to locate the ink bottle numbers.

To order original HP supplies for the HP DeskJet GT 5810 series , go to www.hp.com/buy/supplies . If 
prompted, choose your country/region, and then follow the prompts to find the right ink bottles for your 
printer.

NOTE: Ordering ink bottles online is not supported in all countries/regions. If it is not available in your 
country/region, you may still view supplies information and print a list for reference when shopping at a local 
HP reseller.
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Print with black ink only
Before printing with black ink only, make sure the actual ink levels in all tanks are no lower than the minimum 
ink lines. Printing with any ink level lower than the minimum line may cause damage to your printer.

To print with black ink only(Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. On the Layout or Paper/Quality tab, click the Advanced button to open the Advanced Options dialog 
box.

Print in Grayscale allows you to print a black and white document using the black ink only. Select Black 
Ink Only, and then click OK.

To print with black ink only (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

NOTE: Locations for the options can vary from one application to another. 

4. From the pop-up menu, choose Paper Type/Quality.

5. From the Color pop-up menu, choose Grayscale, and then click Print.
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Tips for working with ink and printhead
Printhead tips

Use the following tips to work with printheads:

● To protect the printheads from drying out, always turn the printer off using the Power button, and wait 
until the Power button light goes out.

● Do not open or untape printheads until you are ready to install them. Leaving tape on the printheads 
reduces ink evaporation.

● Insert the new printheads into the correct slots. Match the color and icon of each printhead to the color 
and icon for each slot. Make sure the printheads snap into place, and then close the blue printhead latch. 
After new printheads are installed and the ink system is primed, do not remove the printheads.

● Align the printer for best print quality. See Printing issues on page 65 for more information.

Ink tips

Use the following tips to work with ink:

● Make sure the ink tanks are filled with ink and the ink levels are above the minimum line before printing.

● Refill the ink tanks when the ink levels reach the minimum line. Printing with the ink level below the 
minimum line may cause damage to your printer.

● Do not make the ink level be above the maximum line by overfilling the ink tanks or tilting the printer. 
The ink level higher than the maximum line can cause ink leaks and ink mixing.

● Turn the ink valve to the locked position to prevent ink leaks when moving or transporting the printer. 
Make sure valve is unlocked after moving or transporting the printer to enable printing.
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6 Connect your printer

● Connect your printer to your computer with a USB cable (non-network connection)
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Connect your printer to your computer with a USB cable (non-
network connection)

The printer supports a rear USB 2.0 High Speed port for connection to a computer.

To connect the printer with the USB cable

1. Insert the printer software CD in the computer CD-ROM drive.

NOTE: Do not connect the USB cable to the printer until you are prompted to do so.

2. Follow the on-screen instructions. When you are prompted, connect the printer to the computer by 
selecting USB on the Connection Options screen.

3. Follow the onscreen instructions.

If the printer software has been installed, the printer will operate as a plug-and-play device. If the software 
has not been installed, insert the CD that came with the printer and follow the on-screen instructions.
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7 Solve a problem

This section contains the following topics:

● Jams and paper-feed issues

● Printhead issues

● Printing issues

● Copy issues

● Scan issues

● Printer hardware issues

● Control panel error codes

● HP support
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Jams and paper-feed issues
What do you want to do?

Clear a paper jam

Solve paper jam issues. Use an HP online troubleshooting wizard

Instructions for clearing paper jams and resolving issues with paper or the paper feed.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for clearing paper jams

Paper jams can occur in several locations.

Before moving the printer to clear any paper jam, make sure the ink valve is turned to the locked position to 
prevent ink leakage.

After finishing clearing the paper jam, turn the ink valve to the unlocked position.

To clear a paper jam from the input tray

1. Press the Cancel button ( ) to try to clear the jam automatically. If this does not work, complete the 
following steps to clear the jam manually.
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2. Pull the paper gently out of the input tray.

3. Make sure there is no foreign object in the paper path, and then reload paper.

NOTE: The input tray shield can prevent foreign debris from falling into the paper path and causing 
serious paper jams. Do not take down the input tray shield. 

4. Press the Resume button ( ) on the control panel to continue the current job.

To clear a paper jam from the output tray

1. Press the Cancel button ( ) to try to clear the jam automatically. If this does not work, complete the 
following steps to clear the jam manually.

2. Pull the paper gently out of the output tray.

3. Press the Resume button ( ) on the control panel to continue the current job.

To clear a paper jam from the printhead access area

1. Press the Cancel button ( ) to try to clear the jam automatically. If this does not work, complete the 
following steps to clear the jam manually.

2. Remove the jammed paper.

a. Press the Power button ( ) to turn off the printer.
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b. Close the output tray extender, and then rotate the output tray clockwise to stow it in the printer.

c. Open the front door of the printer.

d. Open the printhead access door.

e. If the print carriage is in the center of the printer, slide it to the right.

CAUTION: Do not open the blue printhead latch during this process; otherwise, the printer may 
require new printheads to function.
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f. Remove the jammed paper.

g. Close the printhead access door, and then close the front door.

h. Pull out the output tray and the tray extender.

3. Press the Power button ( ) to turn on the printer.

To clear a paper jam inside of the printer

1. Press the Cancel button ( ) to try to clear the jam automatically. If this does not work, complete the 
following steps to clear the jam manually.

2. Press the Power button ( ) to turn off the printer.

3. Turn the ink valve to the locked position.
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4. Gently turn the printer over, locate the cleanout door on the bottom of the printer, and then pull both 
tabs on the cleanout door to open it.

5. Remove the jammed paper.

6. Close the cleanout door. Gently push the door towards the printer until both latches snap into place.

7. Turn the printer over, and then press the Power button ( ) to turn on the printer.

8. Turn the ink valve to the unlocked position.

Clear a print carriage jam

Resolve a print carriage jam. Use an HP online troubleshooting wizard

If something is blocking the print carriage or it does not move easily, get step-by-step instructions.

NOTE: The HP online troubleshooting wizards may not be available in all languages.
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Read general instructions in the Help for clearing a print carriage jams

1. Open the front door of the printer.

2. Open the printhead access door, and make sure not to open the blue printhead latch if the printheads 
have been primed with ink.

3. Remove any objects, such as paper, that are blocking the print carriage.

NOTE: Do not use any tools or other devices to remove jammed paper. Always use caution when 
removing jammed paper from inside the printer.

Learn how to avoid paper jams
To help avoid paper jams, follow these guidelines.

● Do not overfill the input tray, but make sure that you have at least 5 pages loaded, for best results.

● Keep your printer free of dust and debris by removing paper and closing the input tray when not in use.

● Remove printed papers from the output tray frequently.

● Ensure that paper loaded in the input tray lays flat, and the edges are not bent or torn.

● Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the 
input tray must be the same size and type.

Use HP paper for optimum performance. See Paper basics on page 18 for more information about HP 
paper.

● Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width 
guide does not bend the paper in the input tray.

● Do not force paper too far down in the input tray.

● Do not add paper while the printer is printing. If the printer is about to run out of paper, wait until the out 
of paper message appears before adding paper.

Solve paper-feed problems
What kind of problem are you having?

● Paper is not picked up from the input tray   
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— Make sure paper is loaded in the input tray. For more information, see Load media on page 13.

— Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-
width guide does not bend the paper in the input tray.

— Make sure paper in the input tray is not curled. Uncurl paper by bending it in the opposite direction 
of the curl.

— Clean the paper rollers.

● Pages are skewing   

— Make sure the paper is loaded in the far-right side of the input tray and the paper-width guide is fit 
against the left side of the paper.

— Load paper into the printer only when it is not printing.

● Multiple pages are being picked up  

— Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-
width guide does not bend the paper in the input tray.

— Make sure the input tray is not overloaded with paper.

— Make sure the pieces of the loaded paper are not sticking together.

— Use HP paper for optimum performance and efficiency.

— Clean the paper rollers.

To clean the paper rollers using an automated tool

1. Press the Power button ( ) to turn on the printer.

2. Remove paper from the input tray.

3. Press and hold the Power button ( ), press the Cancel button ( ) three times, press the Start Copy 

Color button ( ) seven times, and then release the Power button ( ).

The printer makes some noise for approximately one minute. Wait until the printer stops making noises 
before you proceed.

4. Try to print. If the problem persists, proceed to clean the paper rollers manually.

To clean the paper rollers manually

1. Gather the following materials:

● A long, lint-free cotton swab

● Distilled, filtered, or bottled water (tap water might damage the printer)

2. Press the Power button ( ) to turn off the printer.

3. Disconnect the power cord from the rear of the printer.

4. Disconnect the USB cable, if it is not already disconnected.
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5. Raise the input tray.

6. Lift and hold the input tray shield.

NOTE: Do not remove the input tray shield. The input tray shield prevents foreign debris from falling 
into the paper path and causing paper jams.

7. Look down through the open input tray and find the gray paper pick rollers. You might need a flashlight 
to illuminate the area.

8. Dampen a long cotton swab with bottled or distilled water, and then squeeze any excess water from the 
cloth.

9. Press the swab against the rollers, and then rotate them upward with your fingers. Apply a moderate 
amount of pressure to remove dust or dirt buildup.

10. Lower the input tray shield.

11. Allow the rollers to dry for 10 or 15 minutes.

12. Reconnect the power cord to the rear of the printer.

13. Reconnect the USB cable to the printer if necessary.

14. Press the Power button to turn on the printer.
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Printhead issues
Identify whether a printhead has a problem

To identify whether printhead has a problem, check the status of the Printhead Alert light and the 
corresponding Printhead icon. For more information, see Control panel lights and display icons status 
on page 8.

Fix printhead problems

CAUTION: The instructions in this section apply only when you install printheads during initial printer setup. 
If printheads have been primed with ink, you must not open the printhead latch. Opening the latch can cause 
permanent damage to the printheads.

If an error occurs after a printhead is installed, or if a message indicates a printhead problem, try removing 
the printhead, verifying the protective piece of plastic tape and plug have been removed from each printhead 
and then reinserting the printhead. If this does not work, clean the printhead contacts. If the problem is still 
not resolved, contact HP Support for assistance.

To verify the printhead installed properly

1. Check that power is on.

2. Close the output tray extender, and then rotate the output tray clockwise to stow it in the printer.

3. Make sure the ink valve is at the unlocked position.

4. Remove and reinsert the printhead.

a. Open the front door of the printer.
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b. Open the printhead access door and wait for the print carriage to move to the center of the printer.

CAUTION: The instructions in the following steps apply only when you install printheads during 
initial printer setup. If printheads have been primed with ink, you must not open the printhead 
latch. Opening the latch can cause permanent damage to the printheads.

c. Push down to open the blue printhead latch.

d. Remove the printhead from the carriage.
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e. Check if there is a plug on top of the printhead or plastic tape on the printhead contacts. If there is, 
remove the plug from top of the printhead and the plastic tape from contacts.

NOTE: Do not touch the electrical contacts on the printhead.

f. Slide the printhead into the slot until it clicks into place.

g. Firmly close the blue printhead latch.

h. Close the printhead access door.
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i. Close the front door of the printer.

5. Pull out the output tray and the tray extender.

To clean printhead contacts

CAUTION: The cleaning procedure should take only a few minutes. Make sure that the printheads are 
reinstalled in the printer as soon as possible. It is not recommended to leave the printheads outside of the 
printer longer than 30 minutes. This could result in damage to the printhead.

1. Check that power is on.

2. Close the output tray extender, and then rotate the output tray clockwise to stow it in the printer.

3. Make sure the ink valve is at the unlocked position.
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4. Open the front door of the printer.

5. Open the printhead access door and wait for the print carriage to move to the center of the printer.

CAUTION: The instructions in the following steps apply only when you install printheads during initial 
printer setup. If printheads have been primed with ink, you must not open the printhead latch. Opening 
the latch can cause permanent damage to the printheads.

6. Push down to open the blue printhead latch.

7. Remove the printhead indicated in the error message.

8. Clean the printhead contacts and printer contacts.
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a. Hold the printhead by its sides with the bottom pointing up and locate the electrical contacts on 
the printhhead.

The electrical contacts are the small gold-colored dots on the printhead.

b. Wipe only the contacts with a dry swab or lint-free cloth.

CAUTION: Be careful to wipe only the contacts, and do not smear any of the ink or other debris 
elsewhere on the printhead.

c. On the inside of the printer, locate the contacts for the printhead.

The printer contacts are the set of gold-colored bumps positioned to meet the contacts on the 
printhead.

d. Use a dry swab or lint-free cloth to wipe the contacts.

9. Reinstall the printhead.

10. Close the latch on the carriage.

11. Close the printhead access door, and then close the front door.

12. Check if the error message has gone away. If you still receive the error message, turn the printer off, and 
then on.
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Printing issues
What do you want to do?

Fix problems with page not printing (unable to print)

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE:  This utility is only available for Windows operation system. 

Troubleshoot problems with 
print jobs not printing.

Use an HP online troubleshooting wizard

Get step-by-step instructions if the printer is not responding or printing.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Read general instructions in the Help for unable to print issues

To resolve print issues (Windows)

Make sure that the printer is turned on and that there is paper in the input tray. If you are still unable to print, 
try the following in order:

1. Check for error messages from the printer software and resolve them by following the on-screen 
instructions.

2. Disconnect the USB cable between your computer and the printer, and then reconnect the USB cable.

3. Verify that the printer is not paused or offline.

To verify that the printer is not paused or offline

a. Depending upon your operating system, do one of the following:

● Windows 10: From the Windows Start menu, click All apps, select Windows System, Control 
Panel, and then click View devices and printers under Hardware and Sound menu.

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Either double-click the icon for your printer or right-click the icon for your printer and select See 
what's printing to open the print queue.

c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer 
Offline.

d. If you made any changes, try to print again.
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4. Verify that the printer is set as the default printer.

To verify that the printer is set as the default printer

a. Depending upon your operating system, do one of the following:

● Windows 10: From the Windows Start menu, click All apps, select Windows System, Control 
Panel, and then click View devices and printers under Hardware and Sound menu.

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as 
Default Printer.

d. Try using your printer again.

5. Restart the print spooler.

To restart the print spooler

a. Depending upon your operating system, do one of the following:

Windows 10

i. From the Windows Start menu, click All apps, and then click Windows System.

ii. Click Control Panel, System and Security, and then click Administrative Tools.

iii. Double-click Services.

iv. Right-click the Print Spooler, and then click Properties.

v. On the General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click Start, and then click OK.

Windows 8.1 and Windows 8

i. Point to or tap the upper-right corner of the screen to open the Charms bar, and then click the 
Settings icon.

ii. Click or tap Control Panel, and then click or tap System and Security.

iii. Click or tap Administrative Tools, and then double-click or double-tap Services.

iv. Right-click or touch and hold Print Spooler, and then click Properties.
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v. On the General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click or tap Start, and then click or 
tap OK.

Windows 7

i. From the Windows Start menu, click Control Panel, System and Security, and then 
Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

Windows Vista

i. From the Windows Start menu, click Control Panel, System and Maintenance, 
Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler service, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

Windows XP

i. From the Windows Start menu, right click My Computer.

ii. Click Manage, and then click Services and Applications.

iii. Double-click Services, and then select Print Spooler.

iv. Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as 
Default Printer.

d. Try using your printer again.

6. Restart the computer.

7. Clear the print queue.

To clear the print queue

a. Depending upon your operating system, do one of the following:
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● Windows 10: From the Windows Start menu, click All apps, select Windows System, Control 
Panel, and then click View devices and printers under Hardware and Sound menu.

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Double-click the icon for your printer to open the print queue.

c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to 
confirm.

d. If there are still documents in the queue, restart the computer and try printing again after the 
computer has restarted.

e. Check the print queue again to make sure it is clear, and then try to print again.

To resolve print issues (OS X)

1. Check for error messages and resolve.

2. Disconnect and reconnect the USB cable.

3. Verify that the product is not paused or offline.

To verify that the product is not paused or offline

a. In System Preferences, click Print & Fax.

b. Click the Open Print Queue button.

c. Click a print job to select it.

Use the following buttons to manage the print job:

● Delete: Cancel the selected print job.

● Hold: Pause the selected print job.

● Resume: Continue a paused print job.

● Pause Printer: Pause all print jobs in the print queue.

d. If you made any changes, try to print again.

4. Restart the computer.

Fix print quality issues

Step-by-step instructions for resolving most print quality issues. Troubleshoot print quality issues online
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Read general instructions in the Help for resolving print quality issues

NOTE: To protect the printheads from drying out, always turn the printer off using the Power button, and 
wait until the Power button light goes out. 

To improve print quality

1. Make sure you are using original HP printheads and ink.

● Make sure all ink tanks are filled above the minimum line.

● Consider refilling the ink tanks if the ink is reaching the minimum line.

2. Check the paper type.

● For best print quality, use high quality HP paper, or papers that adhere to the ColorLok® standard. 
For more information, see Paper basics on page 18.

● Always make sure the paper you are printing on is flat. For best results when printing images, use 
HP Advanced Photo Paper.

● Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in a 
cool, dry place. When you are ready to print, remove only the paper you plan to use immediately. 
When you have finished printing, return any unused photo paper to the plastic bag. This prevents 
the photo paper from curling.

3. Check the printer software to see that the print settings are appropirate for the paper type you are 
using. For more information about print settings, see Printer settings tips on page 30

4. Press and hold the Start Copy Color button ( ) on the control panel for 3 seconds to print a 

diagnostics page.
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5. Review the Cyan, Magenta, Yellow, and Black Boxes along with other content on the diagnostics page.

6. Clean the printheads (cartridges), if the diagnostic page shows steaks or missing portions of the color 
and black boxes.

7. Align the printheads (cartridges) if you have seen jagged lines, or if the diagnostic page indicates that 
could help.

8. If print quality problems persist after cleaning and aligning printheads (cartridges), contact HP support.

To clean the printheads (cartridges) (Windows)

CAUTION: Clean the printheads (cartridges) only when necessary. Unnecessary cleaning wastes ink and 
shortens the life of the printheads (cartridges).

1. Load letter or A4 unused plain white paper into the input tray.

2. Open the printer software. For more information, see Open the HP printer software (Windows) 
on page 20.
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3. In the printer software, click Print & Scan and then click Maintain Your Printer to access the Printer 
Toolbox.

4. Click Clean Ink Cartridges on the Device Services tab. Follow the on-screen instructions.

To align the printheads (cartridges) (Windows)

1. Load letter or A4 unused plain white paper into the input tray.

2. Open the printer software. For more information, see Open the HP printer software (Windows) 
on page 20.

3. In the printer software, click Print & Scan and then click Maintain Your Printer to access the printer 
toolbox.

The printer toolbox appears.
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4. Click Align Ink Cartridges on the Device Services tab.

The printer prints an alignment page.

5. Follow the on-screen instructions to load the printhead alignment page print side down on the scanner 
glass, and then click Scan to scan the alignment page.

The printer aligns the printheads. Recycle or discard the printhead alignment sheet.

To clean the printheads (cartridges) (OS X)

CAUTION: Clean the printheads only when necessary. Unnecessary cleaning wastes ink and shortens the life 
of the printheads.

1. Load Letter or A4 plain, white paper in the paper tray.

2. Open HP Utility.

NOTE: HP Utility is located in the Applications/HP folder.

3. Select the HP DeskJet GT 5810 series from the list of devices at the left of the window.
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4. Click Clean Printheads.

5. Click Clean, and follow the on-screen instructions.

6. Click All Settings to return to the Information and Support pane.

To align the printheads (cartridges) (OS X)

1. Load Letter or A4 plain, white paper in the paper tray.

2. Open HP Utility.

NOTE: HP Utility is located in the Applications/HP folder.

3. Select the HP DeskJet GT 5810 series from the list of devices at the left of the window.

4. Click Align.

5. Click Align and follow the onscreen instructions.

6. Click All Settings to return to the Information and Support pane.
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Copy issues
Troubleshoot copy problems. Use an HP online troubleshooting wizard

Get step-by-step instructions if the printer does not create a copy, or if your printouts are low quality.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Tips for copy and scan success on page 38
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Scan issues
HP Print and Scan 
Doctor

The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE:  This utility is only available for Windows operation system. 

Solve scan problems Use an HP online troubleshooting wizard

Get step-by-step instructions if you cannot create a scan or if your scans are low quality.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Tips for copy and scan success on page 38

ENWW Scan issues 75

http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-924&h_keyword=lp70044-win&h_client=s-h-e004-01&h_lang=en&h_cc=us
http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-924&h_keyword=lp70044-win&h_client=s-h-e004-01&h_lang=en&h_cc=us
http://www.hp.com/embed/sfs/doc?client=IWS-eLP&lc=en&cc=us&ProductNameOID=7840163&TapasOnline=TSHOOT_SCAN


Printer hardware issues
Close printhead access door

● Printhead door must be closed to begin printing.

The printer shuts down unexpectedly

● Check the power and power connections.

● Make sure the printer's power cord is connected firmly to a functioning power outlet.

NOTE: When Auto-Off is enabled, the printer will automatically turn off after 2 hours of inactivity to help 
reduce energy use. For more information, see Auto-Off on page 23.

Resolve printer failure

● Turn the printer off, then on. If that does not resolve the problem, contact HP.

76 Chapter 7   Solve a problem ENWW



Control panel error codes
If the Number of copies icon on the printer display is alternating between the letter E and a number, it 
indicates the printer is in an error state. The letter E and the number work as error codes. For example, if the 
Number of copies icon is alternating between the letter E and the number 4, it indicates that a paper jam has 
occurred.

To identify the error code and its corresponding solutions, see the information about the Number of copies 
icons in Control panel lights and display icons status on page 8.
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HP support
For the latest product updates and support information, visit the HP DeskJet GT 5810 series support website 
at www.hp.com/support. HP online support provides a variety of options for help with your printer:

Drivers & downloads: Download software drivers and updates, as well as product manuals and documentation 
that came in the box with your printer.

HP support forums: Visit HP Support Forums for answers to common questions and issues. You can view 
questions posted by other HP customers, or sign in and post your own questions and comments.

Troubleshooting: Use HP online tools to detect your printer and find recommended solutions.

Contact HP
If you need help from an HP technical support representative to solve a problem, visit the Contact Support 
website. The following contact options are available at no cost for in-warranty customers (HP agent-assisted 
support for out-of warranty customers may require a fee):

Chat with an HP support agent online.

Call an HP support agent.

When contacting HP support, be prepared to provide the following information:

● Product name (Located on the printer, such as HP DeskJet GT 5810)

● Product number (located inside the front door)

● Serial number (located on the back or bottom of the printer)

Register printer
By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and 
product support alerts. If you did not register your printer while installing the software, you can register now 
at http://www.register.hp.com.
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Additional warranty options
Extended service plans are available for the HP DeskJet GT 5810 series at additional costs. Go to 
www.hp.com/support , select your country/region and language, then explore the extended warranty options 
available for your printer.
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A Technical information

The technical specifications and international regulatory information for the HP DeskJet GT 5810 series are 
provided in this section.

For additional specifications, see the printed documentation that came with the HP DeskJet GT 5810 series .

This section contains the following topics:

● HP Company notices

● Specifications

● Environmental product stewardship program

● Regulatory notices
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HP Company notices
The information contained herein is subject to change without notice.

All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior 
written permission of HP, except as allowed under the copyright laws. The only warranties for HP products 
and services are set forth in the express warranty statements accompanying such products and services. 
Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical 
or editorial errors or omissions contained herein.

© Copyright 2015 HP Development Company, L.P.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries.
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Specifications
Technical specifications for the HP DeskJet GT 5810 series are provided in this section. For more product 
specifications, see the Product Data Sheet at www.hp.com/support .

System requirements

● Software and system requirements can be found in the Readme file, which is available on the HP printer 
software CD provided with your printer.

● For information about future operating system releases and support, visit the HP online support website 
at www.hp.com/support .

Environmental specifications

● Recommended operating temperature range: 15ºC to 30ºC (59ºF to 86ºF)

● Allowable operating temperature range: 5ºC to 40ºC (41ºF to 104ºF)

● Humidity: 15% to 80% RH non-condensing; 28ºC maximum dewpoint

● Nonoperating (Storage) temperature range: –40ºC to 60ºC (–40ºF to 140ºF)

● In the presence of high electromagnetic fields, it is possible the output from the HP DeskJet GT 5810 
series may be slightly distorted

● HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected 
noise due to potential high electromagnetic fields

Input tray capacity

● Plain paper sheets (80 g/m2 [20lb]): Up to 60

● Envelopes: Up to 5

● Index cards: Up to 20

● Photo paper sheets: Up to 20

Output tray capacity

● Plain paper sheets (80 g/m2 [20lb]): Up to 25

● Envelopes: Up to 5

● Index cards: Up to 10

● Photo paper sheets: Up to 10

Paper size

● For a complete list of supported media sizes, see the printer software.

Paper weights

● Plain Paper: 64 to 90 g/m² (16 to 24 lb)

● Envelopes: 75 to 90 g/m² (20 to 24 lb)
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● Cards: Up to 200 g/m² (110-lb index maximum)

● Photo Paper: Up to 280 g/m² (75 lb)

Print specifications

● Print speeds vary according to the complexity of the document

● Method: drop-on-demand thermal inkjet

● Language: PCL3 GUI

Copy specifications

● Digital image processing

● Copy speeds vary according to the complexity of the document and model

Scan specifications

● Resolution: up to 1200 x 1200 ppi optical

For more information about ppi resolution, see the scanner software.

● Color: 24-bit color, 8-bit grayscale (256 levels of gray)

● Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)

Print resolution

● For a list of supported print resolutions, visit the HP DeskJet GT 5810 series support website at 
www.hp.com/support.

Printhead yield

● Visit www.hp.com/go/learnaboutsupplies for more information on estimated printhead yields.

Acoustic information

● If you have Internet access, you can access acoustic information from the HP website.
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Environmental product stewardship program
HP is committed to providing quality products in an environmentally sound manner. Design for recycling has 
been incorporated into this product. The number of materials has been kept to a minimum while ensuring 
proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and 
other connections are easy to locate, access, and remove using common tools. High priority parts have been 
designed to access quickly for efficient disassembly and repair.

For more information, visit HP's Commitment to the Environment Web site at:

www.hp.com/hpinfo/globalcitizenship/environment

● Eco-Tips

● European Union Commission Regulation 1275/2008

● Paper 

● Plastics

● Material safety data sheets

● Recycling program

● HP inkjet supplies recycling program

● Power consumption

● Disposal of waste equipment by users

● Chemical substances

● Declaration of the Presence Condition of the Restricted Substances Marking (Taiwan)

● The Table of Hazardous Substances/Elements and their Content (China)

● Restriction of hazardous substance (India)

● Restriction of hazardous substance (Ukraine)

● Restriction on hazardous substances statement (Turkey)

● EPEAT

● China SEPA Eco Label User Information

● China Energy Label for Printer, Fax and Copier

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. Please visit the HP 
Environmental Programs and Initiatives website for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

European Union Commission Regulation 1275/2008
For product power data, including the power consumption of the product in networked standby if all wired 
network ports are connected and all wireless network ports are activated, please refer to section P14 
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‘Additional Information’ of the product IT ECO Declaration at www.hp.com/hpinfo/globalcitizenship/
environment/productdata/itecodesktop-pc.html.

Paper
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to 
identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions, and 
partners with some of the largest electronic recycling centers throughout the world. HP conserves resources 
by reselling some of its most popular products. For more information regarding recycling of HP products, 
please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in 
many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more 
information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption
HP printing and imaging equipment marked with the ENERGY STAR® logo is certified by the U.S. 
Environmental Protection Agency. The following mark will appear on ENERGY STAR certified imaging 
products:

Additional ENERGY STAR certified imaging product model information is listed at: www.hp.com/go/energystar
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Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, 
you should protect human health and the environment by handing over your waste 
equipment to a designated collection point for the recycling of waste electrical and electronic 
equipment. For more information, please contact your household waste disposal service, or 
go to http://www.hp.com/recycle.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our products 
as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European 
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.
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Declaration of the Presence Condition of the Restricted Substances Marking 
(Taiwan)

限用物質含有情況標示聲明書

Declaration of the Presence Condition of the Restricted Substances Marking

單元 Unit

限用物質及其化學符號

Restricted substances and its chemical symbols

鉛

Lead

(Pb)

汞

Mercury

(Hg)

鎘

Cadmium

(Cd)

六價鉻

Hexavalent 
chromium

(Cr+6)

多溴聯苯

Polybrominated 
biphenyls

(PBB)

多溴二苯醚

Polybrominate
d diphenyl 

ethers

(PBDE)

外殼和紙匣

(External Casings and Trays)

0 0 0 0 0 0

電線 (Cables) 0 0 0 0 0 0

印刷電路板

(Printed Circuit Boards)

－ 0 0 0 0 0

列印引擎(Print Engine) － 0 0 0 0 0

列印機組件 (Print Assembly) － 0 0 0 0 0

噴墨印表機墨水匣 (Print 
Supplies)

0 0 0 0 0 0

列印機配件 (Print Accessory) － 0 0 0 0 0

備考 1.〝超出 0.1 wt %〞及〝超出 0.01 wt %〞係指限用物質之百分比含量超出百分比含量基準值。

Note 1: “Exceeding 0.1 wt %” and “exceeding 0.01 wt %” indicate that the percentage content of the restricted substance exceeds the 
reference percentage value of presence condition.

備考 2.〝0〞係指該項限用物質之百分比含量未超出百分比含量基準值。

Note 2: “0” indicates that the percentage content of the restricted substance does not exceed the percentage of reference value of 
presence.

備考 3.〝－〞係指該項限用物質為排除項目。

Note 3: The “−” indicates that the restricted substance corresponds to the exemption.

若要存取產品的最新使用指南或手冊，請前往 www.support.hp.com。選取搜尋您的產品，然後依照 畫
面上的指示繼續執行。

To access the latest user guides or manuals for your product, go to www.support.hp.com. Select Find your 
product, and then follow the onscreen instructions.
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The Table of Hazardous Substances/Elements and their Content (China)

Restriction of hazardous substance (India)

Restriction of hazardous substance (Ukraine)

Restriction on hazardous substances statement (Turkey)

88 Appendix A   Technical information ENWW



EPEAT

China SEPA Eco Label User Information
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China Energy Label for Printer, Fax and Copier
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Regulatory notices
The HP DeskJet GT 5810 series meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

● Regulatory model identification number

● FCC statement

● Notice to users in Korea

● European Union Regulatory Notice

● Declaration of conformity

Regulatory model identification number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory 
Model Number for your product is SNPRH-1506. This regulatory number should not be confused with the 
marketing name (HP DeskJet GT 5810 All-in-One Printer, etc.) or product numbers (L9U63A, L9U64A, etc.).
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FCC statement

Notice to users in Korea

92 Appendix A   Technical information ENWW



European Union Regulatory Notice

Products bearing the CE marking comply with one or more of the following EU Directives as may be 
applicable: Low Voltage Directive 2006/95/EC, EMC Directive 2004/108/EC, Ecodesign Directive 2009/125/EC, 
R&TTE Directive 1999/5/EC, RoHS Directive 2011/65/EU. Compliance with these directives is assessed using 
applicable European Harmonised Standards. The full Declaration of Conformity can be found at the following 
website: www.hp.com/go/certificates (Search with the product model name or its Regulatory Model Number 
(RMN), which may be found on the regulatory label.)

The point of contact for regulatory matters is:

HP Deutschland GmbH, HQ-TRE, Schickardstrasse 32, 71034 Boeblingen, Germany
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Declaration of conformity

94 Appendix A   Technical information ENWW



Index

B
buttons, control panel 6

C
carriage

clear carriage jams 55
control panel

buttons 6
features 6
status icons 7

copy
specifications 83

customer support
warranty 79

E
environment

Environmental product 
stewardship program 84

environmental specifications 82

J
jams

clear 51

M
multi-feeds, troubleshoot 57

O
operating systems supported 82

P
paper

clear jams 51
HP, order 19
skewed pages 57
troubleshoot feeding 56

paper-feed problems, troubleshoot
56

power
troubleshoot 76

print
specifications 83
troubleshoot 76

printer software (Windows)
opening 20

R
recycle

ink cartridges 85
regulatory notices 91

regulatory model identification 
number 91

S
scan

scan specifications 83
skew, troubleshoot

print 57
specifications

system requirements 82
status icons 7
system requirements 82

T
technical information

copy specifications 83
environmental specifications 82
print specifications 83
scan specifications 83

trays
clear paper jams 51
troubleshoot feeding 56

troubleshoot
multiple pages are picked 57
paper not picked up from tray

56
paper-feed problems 56

power 76
print 76
skewed pages 57

W
warranty 79
Windows

system requirements 82

ENWW Index 95


	HP DeskJet GT 5810 series Help
	Get started
	Printer parts
	Get to know the ink tank system
	Control panel features
	Overview of buttons and lights
	Control panel display icons

	Control panel lights and display icons status
	Power button light
	Printhead icons and Printhead Alert light
	Printhead priming and alignment icons
	Error icon, Paper Error icon, and Resume light
	Number of copies icon
	Ink system maintenance icon

	Load media
	Load an original on the scanner glass
	Paper basics
	Recommended papers for printing
	Order HP paper supplies

	Open the HP printer software (Windows)
	Sleep mode
	Quiet Mode
	Auto-Off

	Print
	Print from your computer
	Print documents
	Print photos
	Print envelopes
	Print using the maximum dpi

	Tips for print success
	Printhead and ink tips
	Paper loading tips
	Printer settings tips
	Notes


	Copy and scan
	Copy documents
	Scan using the HP printer software
	Scan from a computer
	Change scan settings (Windows)
	Create a new scan shortcut (Windows)

	Tips for copy and scan success

	Manage ink and printhead
	Ink valve
	Ink levels
	Refill Ink Tanks
	Order ink supplies
	Print with black ink only
	Tips for working with ink and printhead

	Connect your printer
	Connect your printer to your computer with a USB cable (non-network connection)

	Solve a problem
	Jams and paper-feed issues
	Clear a paper jam
	Read general instructions in the Help for clearing paper jams

	Clear a print carriage jam
	Read general instructions in the Help for clearing a print carriage jams

	Learn how to avoid paper jams
	Solve paper-feed problems

	Printhead issues
	Identify whether a printhead has a problem
	Fix printhead problems

	Printing issues
	Fix problems with page not printing (unable to print)
	Read general instructions in the Help for unable to print issues

	Fix print quality issues
	Read general instructions in the Help for resolving print quality issues


	Copy issues
	Scan issues
	Printer hardware issues
	Control panel error codes
	HP support

	Technical information
	HP Company notices
	Specifications
	Environmental product stewardship program
	Eco-Tips
	European Union Commission Regulation 1275/2008
	Paper
	Plastics
	Material safety data sheets
	Recycling program
	HP inkjet supplies recycling program
	Power consumption
	Disposal of waste equipment by users
	Chemical substances
	Declaration of the Presence Condition of the Restricted Substances Marking (Taiwan)
	The Table of Hazardous Substances/Elements and their Content (China)
	Restriction of hazardous substance (India)
	Restriction of hazardous substance (Ukraine)
	Restriction on hazardous substances statement (Turkey)
	EPEAT
	China SEPA Eco Label User Information
	China Energy Label for Printer, Fax and Copier

	Regulatory notices
	Regulatory model identification number
	FCC statement
	Notice to users in Korea
	European Union Regulatory Notice
	Declaration of conformity


	Index

